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1. NOTICE 

This guide has been written by the Dassault Systèmes Academia Department to help 

students order and install CATIA Student Edition. 

It not only proposes step by step instructions but also includes frequently asked questions 

and troubleshooting sections inspired by the CATIA Student Edition online community (see 

below). References to community questions and posts are shown in grey. 

This guide MUST NOT be used by commercial customers, should they be academic 

institutions of industrial customers. 

2. SUPPORT 

Support is limited to the purchase and installation phases. Should you have any question, 

please use the CATIA Student Edition support community at: 

https://swym.3ds.com/#community:514 

Answers to frequently asked questions can be found under the iQuestion tab. You may 

check the FAQ by entering a few words in the text field: 

 

Should you want to ask a question, press the “Ask an iQuestion” button on the right hand 

side.  

 

Please provide us with as many details as possible to help us answer your question as 

rapidly as possible. Screenshots are extremely helpful for us. You may attach screen 

captures by using the “Add media from” panel on the right: 

 

https://swym.3ds.com/%23community:514


Support website: https://swym.3ds.com/#community:514 
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3. PREREQUISITES 

CATIA V5 Student Edition exclusively runs on Microsoft Windows. Some users reported it 

also works on MacOS but please note we don’t provide support in such case. 

A network adapter, preferably an Ethernet one, is required as well as a recent 3D graphic 

card. 

Dassault Systèmes provides a list of officially certified configurations but they are often 

unaffordable for students:  http://www.3ds.com/support/certified-hardware 

However, CATIA Student Edition is known for working well with most recent and decent 

PCs. 

Notes: 

 CATIA Student Edition isn't certified on Windows 7 32-bit. 

 CATIA Student Edition isn't certified on Windows 8 and Windows 10 but some 

students reported it works well 

NB: Windows 10 will be certified soon on further CATIA V5 Student Edition releases 

 ATI Radeon graphic cards are not supported. CATIA Student Edition will not work 

with this GPU. 

A. Differences between CATIA V5 Student Edition and the 

"commercial" version 

 

There is no major difference between CATIA V5 Student Edition and its corresponding 

commercial license. From a capacity point of view, they are identical but produced parts and 

products are watermarked, so they cannot be used with a commercial license. 

B. Included Workbenches 

 

CATIA Student Edition isn’t an all-in-one version. It includes a set of mechanical design-

oriented workbenches: 

 3 Axis Surface Machining 2 (SMG) -- Easily defines 3-axis milling and drilling 

operations. 

 Part Design (PDG) –Helps to design complex parts with highly productive and robust 

modeling features in an intuitive environment. 

 Assembly Design 2 (ASD) -- Easily defines mechanical assembly constraints 

automatically positions parts and checks assembly consistency 

 Generative Drafting 2 (GDR) --Generates drawings from 3D parts and assembly 

designs with assistance to manage complex schema. 

 Interactive Drafting 1 (ID1) -- Addresses 2D design drawing production requirement 

http://www.3ds.com/support/certified-hardware


Support website: https://swym.3ds.com/#community:514 
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 Functional Molded Part (FMP) – Is a new generation product for designing cast, 

molded and forged parts and related tooling with unmatched productivity and 

flexibility. 

 Structure Design 1 (SR1) –Helps to rapidly design structures using catalogues of 

standard or custom sections. SR1 enables to simply and quickly creates linear, 

curved structures, and plates, using standard or user-defined sections. Taking 

advantage of an optimized user interface, the user can easily create and modify 

structures thanks to fully associative design in context capability. 

 Sheetmetal Design (SMD) – Helps to design sheet metal parts in a very intuitive and 

productive environment. 

 Real Time Rendering 2 (RTR) --Enables designers to interactively create realistic 

and dynamic renderings and animations in real-time, by extensively using all the 

hardware features available. 

 Generative Shape Design (GSD) -- Helps to design advanced shapes that are based 

on a combination of wireframe and extensive multiple surfaces. It includes high-level 

features with full specification capture and reuse. 

 Imagine and Shape (IMA) -- Enables designers and engineers to quickly, intuitively, 

transform a shape idea into a 3D geometric model. Probably one of students' favorite 

applications! 

 DMU Kinematics Simulator (KIN) -- Defines, simulates, and analyzes mechanisms for 

digital mock-ups of all sizes. 

 Photo Studio (PHS) -- Generates high quality photo-realistic images and movies of a 

digital mock-up, by using a powerful ray-tracing engine. 

 Photo Studio Optimizer (PHO) -- Is an essential complement to Photo Studio for 

users who want to create images and movies that will match reality. PSO extends 

PHS's rendering capabilities with such advanced technologies as global illumination 

and caustics. 

 Freestyle Sketch Tracer (FSK) -- Allows the integration of stylists' work (such as 2D 

painting) into a 3D format, as the basis for 3D virtual mock-ups. 

 Freestyle Shaper 2 (FSS) -- Provides powerful easy-to-use surface-based tools to 

help designers create styled shapes, enabling even casual users to easily smooth 

and trim curves and surfaces. 

And also... 

DMU Space Analysis 2 (SPA), Plant Layout 1 (PLO), Generative Part Structural Analysis 2 

(GPS), NC Manufacturing Review 2 (NCG), Prismatic Machining 2 (PMG), Lathe Machining 

2 (LMG), STL Rapid Prototyping (TL1), Object Manager 2 (COM), Instant Collaborative 

Design 1 (CD1), IGES Interface 1 (IG1). 

https://swym.3ds.com/#community:514/iquestions:11835 
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    8      

 

3
D

S
.C

O
M

 ©
 D

a
s
s
a

u
lt
 S

y
s
tè

m
e

s
 |
 C

o
n

fi
d

e
n

ti
a
l 
In

fo
rm

a
ti
o

n
 |
 5

/2
3

/1
4

 |
 r

e
f.

: 
3

D
S

_
D

o
c
u

m
e

n
t_

2
0

1
4

 

 

3
D

S
.C

O
M

 ©
 D

a
s
s
a

u
lt
 S

y
s
tè

m
e

s
  

| 
 C

o
n

fi
d
e

n
ti
a

l 
In

fo
rm

a
ti
o

n
  

| 
 0

1
/0

2
/2

0
1

2
  
re

f.
: 

D
o
c
u

m
e

n
t_

R
e
fe

re
n

c
e

 |
 

C. Available CATIA Student releases 

 

You can find below the official life cycle dates for each CATIA Student releases.  

Release Release date Full support end 

V5R20 19-Feb-10 19-Oct-12 

V5R21 17-Jun-11 17-Feb-14 

V5-6R2012 17-Feb-12 17-Oct-14 

V5-6R2013 15-Feb-13 15-Oct-15 

V5-6R2014 7-Mar-14 7-Nov-16 

V5-6R2015 13-Mar-15 13-Nov-17 

V5-6R2016 1-Nov-16 4-Oct-18 

  

https://swym.3ds.com/#post:17340 

D. End User Agreement 

 

The Student License Agreement sets some usages for CATIA Student Edition. In particular: 

 You must install the software on a computer owned or/and leased by you [...] 

identified in the order, placed by you by type, serial number, target ID and installation 

address. (article 1) 

 [You must be] a natural person (i) regularly enrolled as a student in an academic 

program, (ii) holding a valid registration receipt for the current semester or a valid 

letter of enrollment on school letterhead for the current year (iii) who is registered on 

3DS Academy. (article 1) 

 CATIA V5 may only be operated by you, on your personal computer and only for your 

individual, personal and non-commercial learning, academic and/or research 

purposes, excluding any other purposes such as but without limitation any direct or 

indirect industrial, commercial and/or business purposes. (article 2) 
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4. REGISTRATION 

To apply, please follow the steps shown on the following video: 

There are two ways to register, both lead to the same end. 

You can complete the full registration (a) and buying processes directly or can create a 3DS 

public profile (b) and finish your academic registration later. 

 

The full registration path is:  go to CATIA V5 Student Edition page and click on “BUY 

NOW” (same process for ICEM Surf Student Edition) 

A pop-in will open, choose Sign-up and fill the form, then click on “Create account”: 

Note: you can directly use your academic email address to create your account, it’s the 

fastest and easiest method to get your student account validated later. 

  

Once this account created (the public profile), you have to confirm your academic status. 

To do so, click on Student (if you don’t see it, you are automatically entered in the student 

process) and fill the required information: to confirm your student status, you can use either 

your academic email address or a proof of Student status (as explained in the FAQ: in 

registration). 

https://academy.3ds.com/en/software/catia-v5-student-edition
https://academy.3ds.com/en/software/icem-surf-student-edition
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3 options are available: 

 

1/ You have already used your academic email address, then click on Next 

 

2/ You registered with a personal email address, add your academic email address to 

confirm your status by clicking on “My school-issues email is:” and type your email > Next 

 

3/ You don’t have an academic email address, in that case, fill the information, click on Next 

and then choose your University in the list and ad your Academic ID proof (your request will 

be reviewed shortly after). 

Note: To create a 3DS public profile, you can also click on the CONNECT button at the top 

of the page and “Sign Up”. Fill up the form and confirm to create the account. 

Please note that this profile still needs the academic approval (student/teacher), to confirm 

your student status, you will have to go to the CATIA V5 Student Edition page and click on 

buy to activate the academic approval process. 

 

If you need more help, don’t hesitate to ask your question on our SwYm’ Community. 
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5. ORDERING 

You are now on the “BILLING” page. To order, please follow the steps shown below: 

 

1/ Fill your Billing Information: First name, last name, billing address, City, Zip Code  

 

2/ Choose your Payment Method  

 You can pay with PayPal or by Credit Card: click to choose and follow the process (you 

will have to login to PayPal if you want to use this payment method). 

 



Support website: https://swym.3ds.com/#community:514 
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3/ On the right, in “ORDER SUMMARY”, read and approve the conditions (conditions of 

sales & license agreement) and click on the button to approve them. 

 

Note: If you have a promo code, you can click on “Got a coupon/promo-code”. Otherwise, 

leave this field empty 

4/ Click on “Proceed to payment” to confirm your order.  

Your order is now approved, you can go to your Download Center and follow the next step. 

 

Once your payment is completed on credit card or Paypal, it will take a few minutes 

(between 5 and 30 minutes) for our servers to process it. Please be patient and do not order 

again. Should you need assistance, please open an iQuestion. 

Note: you cannot purchase multiple times the same software but there is no downloading 

restriction (you can download the software as much as you want) in the Download Center 

(see 9.FAQ > D.7 How to download the software later or change your release). 

  



Support website: https://swym.3ds.com/#community:514 
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6. DOWNLOAD 

When your order will be completed, you will receive an email from dsstore@3dstore.com 

which is a receipt of your order. The next steps are also explained in it:  

1/ Go To your Download Center 2/ Download your Software 3/ Generate a license for your 

computer 4/ Install the license into your computer. 

Once read, click on the DOWNLOAD  button to access to your Download Center. 

- In your Download Center, 2 tabs are available: 

 Instructions: contains CATIA installation files and full installation process explanation 

 Additional Media: contains the CATIA HTML documentation 

(DOC_CATIA_STUDENT.media.1-1.zip) 

- To install CATIA Student Edition, go to Instructions and follow the steps mentioned: 

 

 Step 1 - Download the software and select the correct release 

Note:  The files mentioned with “Windows 64” are the 64-bits installers. 

Download the installer which corresponds to your operating system.  

 

 
 

 Step 2 - Generate a license for your computer  

(more information about this step in the next paragraph A. Target ID generation) 

 

A - Download the "TARGET-ID Generator" Program 

B - Once your TARGET-ID obtained, please paste it on the following box to generate a 

license key for your computer. 

 

 Step 3 - Install your CATIA - Design for Student Configuration  

(more information about this step in the paragraph 7. SETUP)  

 

A - Install CATIA - Design for Student Configuration 

B - Import your license key (.lic file) using the "Nodelock Key Management", this program 

installed with CATIA is available in your start menu or by using the Windows search tool 

(more information about this step in the paragraph 8. LICENSING) 

If you ever delete the email message by mistake, you may visit https://academy-

store.3ds.com/myaccount/jsp/download/download-center.jsp  

 

https://swym.3ds.com/#community:514/iquestions:11919  

mailto:dsstore@3dstore.com
https://academy-store.3ds.com/myaccount/jsp/download/download-center.jsp
https://academy-store.3ds.com/myaccount/jsp/download/download-center.jsp


Support website: https://swym.3ds.com/#community:514 
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A. Target ID generation 

 

At step 2 of the installation process, you will be asked to provide a Target ID. This is the 

trickiest part of the CATIA installation. 

1) What is a Target ID? 

The "Target ID" is a code calculated on your computer. It identifies your computer and it is 

used to generate your license key. 

The calculation of the Target ID has to be performed on the computer where CATIA 

Student Edition will be used. 

https://swym.3ds.com/#community:514/iquestions:11812 

2) Target ID Generator 

To determine your Target ID, you will use the "TARGET-ID Generator for students" (also 

known as “TIGER”). 

The Target ID Generator aims at making students life easier. It is not officially supported by 

Dassault Systèmes and must NOT be used by commercial customers. 

This small application automatically runs complex command lines to make sure the Target 

ID you'll get will be valid and won't ever change. Also, it will set one Windows environment 

variable. 

https://swym.3ds.com/#post:13884 

3) Download the generator 

Download the following file and extract it in a temporary directory (your Windows desktop or 

download folder for example): 

 

http://www.3ds.com/fileadmin/general/Terms/Software keys/TARGET-ID generator.zip     

 You can also download the TARGET-ID Generator directly in your Download Center (in 

the installation steps of the software) 

 

http://www.3ds.com/fileadmin/general/Terms/Software%20keys/TARGET-ID%20generator.zip


Support website: https://swym.3ds.com/#community:514 
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4) Run the generator 

Right-click on “tiger_new.exe” and select “Run as administrator”: 

 

Select your Ethernet adapter:  

 

Press the button located under the adapter list. Your Target ID will appear in the text field. 

The Target ID looks like a 20-character code linked to your CATIA V5 release (for example: 

DMX-430B10DEF171774F, GZV-42B814EE75399182). 

NB: Once the code generated, a log file is also created in the same folder 

 

 You may now copy it and paste it in the online order form.  

 

 Click on “Activate my Computer” to create the license file (.lic) which will be sent by email 

shortly after 
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7. SETUP 

 Find below the Installation steps: 

1) Download and unzip the zip files 

 

Download the zip file in a temporary directory (C:\Downloads\temp in our example). 

 

This example is based on R2015, 64b edition, it is the same process for any other version 

and for 32b. 

 

NB: CATIA V5 Student Edition install package is composed of only one ZIP file. 

The Documentation install package must be used separately. 

Extract the zip file in the current folder. Then, double click on “Setup.exe” 

2) Welcome screen 

 

Press “Next” 

 



Support website: https://swym.3ds.com/#community:514 
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3) License 

 

You will import the license key later on, using the Nodelock Management tool. For now, 

press Next 

 

4) Installation Directory 

 

Choose the directory where CATIA V5 data will be copied. Around 2Gb are necessary. We 

recommend using the default location. Press "Next". 
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5) Environment 

 

Setup needs to create a file containing the runtime environment variables required for 

starting a CATIA V5 session. We recommend you keep the default value. Press "Next". 

 

6) Setup type 

 

Pick "Complete" and press "Next". 
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7) Press Next until you get a recap 

 

This screen summarizes the different options that you selected. Press "Next" to start the 

installation. 

 

8) Installation in progress 

 

Wait until all the data is copied to your hard drive. 

 

 

Installation is now over. 

To finalize it, you now have to import your license. Follow step 8.Licensing at the next page. 
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8. LICENSING 
 

 Import the license key received by email 

Save the .LIC file received by email in a temporary directory 

 

 

[Windows XP, Vista, Windows 7] From the Windows start menu, select:  

- Start > All Programs > CATIA STUDENT > Tools > Nodelock Key Management V5-6R20xx 

- For [Windows 10], > CATIA STUDENT > Nodelock Key Management V5-6R20XX 

 

Cannot find Nodelock on Windows 10? Please check E.8 “You cannot find Nodelock Key 

Management” 
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[Windows 8] Use the search button (available in the “Charm Bar” or in the “Apps Menu”) 

and type “Nodelock Key Management” to find it 

 

 
 

Use the menu to select: 

File > Import 

 

Pick the .LIC file you previously saved on your hard drive. Your CATIA Student Edition 

license (CS1) should appear in the list after the import. 

You’re done! 

Congratulations! You are now done and you may now shape your ideas in 3D. 

Enjoy CATIA V5. 
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9. FREQUENTLY ASKED QUESTIONS (FAQ) 

A. Registration and Ordering 

1) In which countries is CATIA V5 Student Edition available? 

CATIA V5 Student Edition is available Worldwide except countries embargoed and 

sanctioned countries or for legal reasons (including Puerto Rico). 

2) What are the conditions for eligibility? 

To purchase either CATIA Student Edition, you must be a student.  

By student, we mean: an individual, REGULARLY ENROLLED IN AN ACADEMIC 

PROGRAM FOR HIS/HER PERSONAL LEARNING excluding any other purposes such as 

but without limitation any direct or indirect industrial, commercial and/or business purposes. 

Participants enrolled in professional training programs are in particular not eligible. 

https://swym.3ds.com/#community:514/iquestions:11791 

3) How long does it take to get approved? 

Requests are reviewed from Monday to Friday (10am-5pm). 

 

Expect from 1 to 5 business days to get approved by our teams. To save time and to avoid 

back and forth emails, be sure to provide us with a valid proof of academic status (see 

paragraph 4)). 

https://swym.3ds.com/#community:514/iquestions:11860 

4) Which proofs of academic status are requested to apply for CATIA Student 

Edition? 

Acceptable forms of academic IDs are the following (only one is required): 

 Scan of a dated and valid student ID 

 Scan of a registration receipt for the current semester/year. 

 Scan of a dated letter of enrollment on school letterhead for the current 

semester/year. 

Examples: 
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https://swym.3ds.com/#community:514/iquestions:11792 

5) What is the license duration? 

The license will expire one year after the payment. 

6) What is a promo code? 

In the Order Summary (at the Billing Step, before the Payment), you can use a promo code if 

you have one. 

 

 

A promo code is used to apply discount rates during special marketing operations (we may 

offer free licenses during events for example). If you didn't receive a code from us, let the 

field empty while ordering. 

https://swym.3ds.com/#community:514/iquestions:11824 

7) Which payment method can I use to purchase CATIA Student Edition? 

Credit card and PayPal are accepted to process student edition orders. 

https://swym.3ds.com/#community:514/iquestions:11803 

8) How to determine if my operating system is 32 or 64-bit? 

 

Please read the corresponding Microsoft knowledge base article at 

http://support.microsoft.com/kb/827218 

http://support.microsoft.com/kb/827218
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9) I didn’t receive the license key by email 

You should receive your license key in less than 30 minutes. The message contains a “.LIC” 

file attached. It is sometimes considered as junk mail by Outlook, Gmail, Yahoo, Hotmail, 

etc. Please double-check in the corresponding folder. For example, should you use Gmail, 

the “SPAM” folder is accessible from the left menu: 

 

Still can’t find the message? You can request again the email with your .Lic (license) file in 

your Download Center: go to your Download Center, select CATIA Student software and go 

directly to Step 2, B/ you should see the following: 

 
 

 Email will be sent on the first email address added when you created your account (can 

be your personal email address if you used it before confirming your account with the 

student email address). 

Still stuck? Please open an iQuestion on our community website. 

B. Request a refund 

 

To request a refund, please use the dedicated form “3DS Academy website” available on 

our website. 

https://academy.3ds.com/en/contact/contact_us 

Choose the topic: “Refund” as shown below 

 

 

  

https://academy.3ds.com/en/contact/contact_us
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C. Request a License transfer (changing computers) 

 

I have changed my computer, how to adapt my license on it? You have to determine your 

new TARGET-ID and modify it in your download Center (license transfer): 

 

To request a license transfer, you have to 

1- Generate the new TARGET-ID corresponding to your new machine (please refer to the 

TARGET-ID article in 6-Download) and get ready to paste it. 

2- Go to your Download Center. 

 To access it, first click on CONNECT at the top of the page (1)  Login (2)  then click 

on your initials (3) to access to your profile which includes your download center. 

 

Once on your download Center (4), choose CATIA Student Edition Software and click on 

“Instructions” (5), scroll to Step B 

 
 

Your license is already activated and your previous TARGET-ID is mentioned in green. 

To update it, paste your new TARGET-ID in the dedicated field and click on “ACTIVATE MY 

COMPUTER”. You will receive shortly after an email with your new license (.lic) file based on 

new the TARGET-ID. 

 

 
 

Once your License file (.lic) received, import it in your Nodelock Management to activate it 

(please refer to the Nodelock Management article in 8-Licensing) 
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    26      

 

3
D

S
.C

O
M

 ©
 D

a
s
s
a

u
lt
 S

y
s
tè

m
e

s
 |
 C

o
n

fi
d

e
n

ti
a
l 
In

fo
rm

a
ti
o

n
 |
 5

/2
3

/1
4

 |
 r

e
f.

: 
3

D
S

_
D

o
c
u

m
e

n
t_

2
0

1
4

 

 

3
D

S
.C

O
M

 ©
 D

a
s
s
a

u
lt
 S

y
s
tè

m
e

s
  

| 
 C

o
n

fi
d
e

n
ti
a

l 
In

fo
rm

a
ti
o

n
  

| 
 0

1
/0

2
/2

0
1

2
  
re

f.
: 

D
o
c
u

m
e

n
t_

R
e
fe

re
n

c
e

 |
 

D. Account and Download Center 

1) How to access to your account 

 

Click on CONNECT at the top of the page (1)  Login (2)  then click on your initials (3) to 

access to your profile 

 

2) How to reset my profile password? 

 

A/ If you don’t remember your current password:  

 Click on the CONNECT button on the top bar, then, on the “?” to activate the Forgot 

Password form 

 
 

 



Support website: https://swym.3ds.com/#community:514 
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B/ If you remember your password but want to change it:  

 Access to your account (CONNECT > Login > click on the top circle with your initials), in 

the Settings tabs, you have your personal information, click on the “Reset Password” button. 

 

3) I need an invoice (billing) 

 

Connect to your Download Center (in my Account) and to the “BILLING” tab.  

Click on the cloud icon on the desired software and an INVOICE .pdf will open. 

 

 

4) I have the error “ACADEMAP TECHNICAL ERROR Your school email is 

already used to validate another account” 

 

 

 

This error happens because you probably have already created an account with your 



Support website: https://swym.3ds.com/#community:514 
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academic email address. 

Please login using this academic email address instead of creating another account. 

If you don’t remember your password, please use the reinitialize function. 

If these solutions don’t help, please contact us. 

5) I have misspelled my email when registering 

 

If you put a wrong email during the registration process, you can still modify it after. 

Connect to your account (with the wrong email address) and go to personal information.  

You can see an email field (as shown below), modify your email here. You will receive an 

email to confirm the modification on your new email address. 

 
 

If you also request again the license, it will be sent on this new email address. 

 

If it doesn’t work, please contact us directly and we will modify your email address. 

Don’t forget to precise the wrong email address and the correct one. 

6) Order delayed : need more information (by email, order in hold)  

 

You received the following email: “ORDER DELAYED” Your order is currently in hold, we 

need additional information from your part” 

To approve your order, you have to send the following additional information: date of birth + 

order number (visible in the email) to 3ds.compliance-export@3ds.com     

 

Note: This email is linked to legal obligations: As a global company with operations and 

customers around the world, DS must comply with the export laws and regulations of the 

numerous countries in which it does business, including those of the United States, as well 

as any export restrictions imposed by international, multilateral institutions. As a result of 

these legal obligations and limitations, we have sometimes to verify student profiles to 

approve orders. 

mailto:3ds.compliance-export@3ds.com


Support website: https://swym.3ds.com/#community:514 
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7) How to download the software later or change your release 

 

To access to your software again, you have to go to the Download Center, to access it, first 

click on CONNECT at the top of the page  Login  then click on your initials to access to 

your profile which includes your download center. 

Once on your download Center, choose CATIA product: you can download your software 

again and change the release if required. 

Note: to change your release: 

a/ Download the new release you want in the Download Center (R2013, R2014, R2015…). 

b/ Uninstall your current CATIA V5 Student Edition 

c/ install the new CATIA V5 release 

d/ Import the .lic (license) file received with your first install in your Nodelock Management 

and you’re done.  

If needed, you can download again the .lic file in the download center: at Step 2, B 

 

E. Installation and TARGET-ID 

1) Error: "setup Problem with VC8 Runtime. Please try to restart your computer or 

contact customer service” 

This error message is generated immediately upon the completion of the Dassault Systemes 

Software Prerequisite x86 installation, at the beginning of the CATIA V5 client installation. 

It is misleading: probably nothing is wrong with the C++ version installed on your computer. 

For example, Microsoft Visual C++ 2005 Redistributable Package (also known as “VC8”). 

This error may be caused by a corrupted CATIA installation package, or a non-complete 

CATIA V5 or CATIA V6 code installation package. It will be generated if parts of the 

installation code are incomplete or became corrupted during the download or 

decompression. 

To ensure that the installer is downloaded and managed properly and to avoid code 

corruption: 

- Make sure that the ZIP file download  is finished before unzipping (see table below) 

- Uncompress it again using 7Zip, WinZip or any efficient uncompression tool and try 

to run a new installation  



Support website: https://swym.3ds.com/#community:514 
  

 
 

    30      

 

3
D

S
.C

O
M

 ©
 D

a
s
s
a

u
lt
 S

y
s
tè

m
e

s
 |
 C

o
n

fi
d

e
n

ti
a
l 
In

fo
rm

a
ti
o

n
 |
 5

/2
3

/1
4

 |
 r

e
f.

: 
3

D
S

_
D

o
c
u

m
e

n
t_

2
0

1
4

 

 

3
D

S
.C

O
M

 ©
 D

a
s
s
a

u
lt
 S

y
s
tè

m
e

s
  

| 
 C

o
n

fi
d
e

n
ti
a

l 
In

fo
rm

a
ti
o

n
  

| 
 0

1
/0

2
/2

0
1

2
  
re

f.
: 

D
o
c
u

m
e

n
t_

R
e
fe

re
n

c
e

 |
 

You can find on the table below the precise file size of each CATIA Student Edition version: 

CATIA version File name 
Expected 
file size 

V5-6R2016 64-bit V5-6R2016.CATIA_STUDENT.win_b64.1-1.zip 985 MB 

V5-6R2015 64-bit V5-6R2015.CATIA_STUDENT.win_b64.1-1.zip 941 MB 

V5-6R2015 32-bit V5-6R2015.CATIA_STUDENT.intel_a.1-1.zip 860 MB 

V5-R2014 32-bit V5-6R2014.CATIA_STUDENT.intel_a.1-1.zip 863 MB 

V5-R2014 64-bit V5-6R2014.CATIA_STUDENT.win_b64.1-1.zip 930 MB  

V5-R2013 32-bit V5-6R2013.CATIA_STUDENT.intel_a.1-1.zip 868 MB 

V5-R2013 64-bit V5-6R2013.CATIA_STUDENT.win_b64.1-1.zip 935 MB 

 

https://swym.3ds.com/#community:514/iquestions:14689 

2) CATIA title bar show "CATIA V5 DEMONSTRATION"? 

You probably checked the "demo" mode by 

mistake. 

 

 

 

To fix the problem:  Select "Tools" > "Options" from the menu  Select the "Licensing" tab 

(as shown below)  Uncheck the demo mode 

 

 You will be asked to restart CATIA V5. Once done, you should see "CATIA V5 for Student" 

in the CATIA title bar. 

https://swym.3ds.com/#community:514/iquestions:11829 
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3) You cannot find Nodelock Key Management 

 

If you cannot find your “Nodelock Key Management”, you can launch the tool directly from 

the installation directory of CATIA Student Edition. The default location of the program is :   

"C:\Program Files\Dassault Systemes\Bxx\win_b64\code\bin" 

(where "Bxx" is the release number of CATIA. For Ex: It is "B25" if you have V5-6R2015 

level installed, "B24" if you have V5-6R2014 installed).  

If you have installed CATIA in another folder or drive, please modify it consequently. 

In "bin" folder search for "DSLicMgt.exe" and double click on this "DSLicMgt.exe".   

Nodelock Key Management tool will be launched.  

4) No license found in nodelock file 

Some users get the following error message: "No license found in nodelock file! C:\Program 

Data\IBM\LUM\NODELOCK" when they run the LUM license manager: 

 

It means that so far there is no license listed in the file named "NODELOCK". This is normal, 

as no license key has been imported until now. 

https://swym.3ds.com/#community:514/iquestions:14291 

5) License not imported. Initial license already present 

 

Should you get the following issue:  

 

Your might have already used another CATIA version. 

In that case, launch your Nodelock Key Management, go to “File” and click on “Clean 

Expired Licenses”  



Support website: https://swym.3ds.com/#community:514 
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If the problem remains, your Nodelock file might be corrupted. 

Please delete the “Nodelock” file located in C:\ProgramData\IBM\LUM (ProgramData is a 

hidden file, to show it, go on “organize” > “folders and search options” > “view” > select 

“Show hidden files, folders, and drives”). Then, import your license file again. 

You can also try the solution [10) You have not requested…] if the issue persists. 

https://swym.3ds.com/#community:514/iquestions:21540 

6) Requested Product not found: XXX.prd or XXX.slt 

 

 

If you obtain the following error with a .slt or .prd at the end of the message (examples: 

_MS2.slt, ELB.prd…), you have probably installed another CATIA on your computer that was 

not a CATIA Student Edition and have probably some remaining licensing information from 

this previous install stored on your machine. 

 You need to clear your CATIA settings (CATSettings) and then restart CATIA to avoid 

these warning messages. 

By default CATSettings are generated in folder: 

C:\Users\user\AppData\Roaming\DassaultSystemes\CATSettings 

You need to delete all settings (CATSettings) present at above location and Import your 

license into "Nodelock Key Management" tool. Then, restart CATIA. 

To know more information about CATSettting you can refer documentation path: CATIA 

Infrastructure > Customizing > Customizing Settings > About Settings > Where Are Settings 

Files Located on Windows? 



Support website: https://swym.3ds.com/#community:514 
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7) You have imported your license but can’t see it in Nodelock or have the 

following issues: “No license server declared” or “Failed to open local license 

file“ 

 

 

 
 

When the import is successful, the license copy is created under the folder 

C:\ProgramData\DassaultSystemes\Licenses (ProgramData folder is hidden) 

Please first check that this path exists on your computer, if not, launch again TIGER (Target-

ID Generator) application in admin mode to set up the environment (if it doesn’t work, you 

can create the “Licenses” folder manually). 

Then, check if you have the license file (.LIC) generated at above location after importing it 

in Nodelock Tool. If it is not present in the folder, paste manually the .LIC file that you have 

received into above folder and then try to start CATIA 

 

 If you still have the issue:  

In the same folder (licenses): check if you already have a text document: DSLicSrv.txt 

- If you don't have one, please create a blank document with the following name 

“DSLicSrv.txt” in the folder. 

- If you already have this document, please rename it into DSLicSrv.txt.old and then create a 

new blank document DSLicSrv.txt which will replace the old one. 
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8) Nodelock management requires write rights on Nodelock file 

 

To fix this issue: 

a) Either browse C:\ProgramData\IBM\LUM and right click on the NODELOCK file. Select 

"Properties" as shown below: 

 

Then, open the "Security" tab, then "Edit" and make sure your Windows user (or even better: 

"Everyone") gets "full control" rights: 



Support website: https://swym.3ds.com/#community:514 
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Or b) run the Nodelock Management tool as an administrator (right click on the menu entry 

as shown below) 

 

https://swym.3ds.com/#community:514/iquestions:14291 
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9) Invalid Timestamp Error 

You may get an "Invalid Timestamp" error when trying to import your .LIC file. 

 

This error occurs when trying to import a LIC file using the DSLS License Manager instead 

of the LUM one. 

Start the LUM License Manager and import the .LIC file. 

10) You have not requested a configuration or product license 

When running CATIA V5 Student Edition, some users get the following error: 

 

Then: 
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The above screenshot shows that CATIA is linked to the DSLS licensing manager instead of 

the LUM one. To fix this issue, run the Target ID Generator again (see paragraph 4)). It will 

set an environment variable to you. 

You may also do it manually (advanced users only): 

 Open the Windows Control Panel. 

 Choose “System and Security” > “System” 

 Click “Advanced System Settings” 

  Select “Environment variables” in the “Advanced” tab as shown below 

  Click “New..” and add a new SYSTEM variable (in ALL UPPERCASE LETTERS, no 

space between words)  

Variable name: DSLICENSING 
Value:         LEGACY 

 

Here is the entire process:  
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https://swym.3ds.com/#community:514/iquestions:12882 

https://swym.3ds.com/#post:12819 

11) No license available for requested configuration – configuration not granted 

If you have the following issues: 

 

You are probably using CATIA through a Remote Desktop connection. This functionality is 

not yet supported for CATIA in its student Edition and your license is not detected. To check 

your display type, you can open your License Manager as shown below: 



Support website: https://swym.3ds.com/#community:514 
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To avoid this issue, run CATIA from the same machine without remote desktop connection. 

12) My Target ID is 00000000 

Should you get the following: 

 

Make sure you used the Target ID Generator to determine your Target ID. 

If you already did, you are probably running a Virtual machine and CATIA will not work. In 

this case: a) use a real machine and request a license transfer, or b) request a refund. 

https://swym.3ds.com/#community:514/iquestions:11798 

https://swym.3ds.com/#community:514/iquestions:16165 


